This chapter covers FEMLAB’s heat transfer application modes. It starts with some background on heat transfer. It then reviews specifics of the Conduction application mode and then the Convection and Conduction application mode. It concludes with FEMLAB models of three heat-transfer examples taken from a NAFEMS (National Agency for Finite Element Methods and Standards) benchmark collection.
Heat Transfer Fundamentals

What is Heat Transfer?

From the kitchen toaster to the latest high-performance microprocessor, heat is ubiquitous and of great importance in the engineering world. To optimize thermal performance and reduce costs, engineers and researchers are making use of finite element analysis. Because most material properties are temperature-dependent, the effects of heat enter many other disciplines and drive the requirement for multiphysics modeling.

For instance, both the toaster and the microchip contain electrical conductors that generate thermal energy as electrical current passes through them. As these conductors release thermal energy, system temperature increases as does that of the conductors. If electrical conductivity is temperature-dependent, it changes accordingly and, in turn, affects the electrical field in the conductor. Other examples of multiphysics couplings that involve heat transfer are thermal stresses, thermal-fluid convection, and induction heating.

Heat transfer is defined as the movement of energy due to a temperature difference. It is characterized by the following three mechanisms:

- **Conduction** is heat transfer by diffusion in a stationary medium due to a temperature gradient. The medium can be a solid or a liquid.
- **Convection** is heat transfer between either a hot surface and a cold moving fluid or a cold surface and a hot moving fluid. Convection occurs in liquids and gases.
- **Radiation** is heat transfer between Surface A at temperature $T_1$ and Surface B at temperature $T_2$ via electromagnetic waves, provided that $T_1 \neq T_2$ and that Surface A is visible to an infinitesimally small observer on Surface B.

**Note:** The Heat Transfer Module supports simulations of all three types of heat transfer mechanism, including surface-to-surface and surface-to-ambient radiation.

The examples later in this chapter shows transient heat transfer by conduction, convection, and radiation. For a model using the Convection and Conduction application mode, see “Heated Rod in Cross Flow” on page 202 in the *FEMLAB Model Library*. For an introductory example of a multiphysics coupling of a heat.
balance to a momentum balance through the Navier-Stokes equations, see “Free Convection Model—A Guided Tour” on page 32 in the *FEMLAB Quick Start*. In that model the heat flux accounts for transport by convection and conduction. The system consists of heated tubes subjected to a stream of a fluid perpendicular to the main axis of the tubes. The tubes heat the streaming medium as it travels from the bottom to the top of the domain.

**The Heat Equation**

The mathematical model for heat transfer by conduction is the heat equation:

\[
\rho C_v \frac{\partial T}{\partial t} - \nabla \cdot (k \nabla T) = Q
\]

Quickly review the variables and quantities in this equation:

- \( T \) is temperature.
- \( \rho \) is density.
- \( C \) is heat capacity.
  - \( C_p \) is heat capacity at a constant pressure.
  - \( C_v \) is heat capacity for a constant volume.
- \( k \) is thermal conductivity.
- \( Q \) is a heat source or heat sink.

For a steady-state model, temperature does not change with time and the first term containing \( \rho \) and \( C \) vanishes.

If the thermal conductivity is anisotropic, \( k \) becomes the thermal conductivity tensor \( k \):

\[
k = \begin{bmatrix}
k_{xx} & k_{xy} & k_{xz} \\
k_{yx} & k_{yy} & k_{yz} \\
k_{zx} & k_{zy} & k_{zz}
\end{bmatrix}
\]

To model heat conduction and convection through a fluid, the heat equation also includes a convective term. FEMLAB represents this formulation in the Convection and Conduction application mode as:

\[
\rho C_v \frac{\partial T}{\partial t} + \nabla \cdot (-k \nabla T + \rho C_p T \mathbf{u}) = Q
\]
where \( \mathbf{u} \) is the velocity field. This field can either be provided as a mathematical expression of the independent variables or calculated by a coupling to a momentum balance application mode such as Incompressible Navier-Stokes.

The heat flux vector is defined by the expression within the parentheses in the equation above. For transport through conduction and convection this equation yields:

\[
\mathbf{q} = -k \nabla T + \rho C_p \mathbf{u}
\]

where \( \mathbf{q} \) is the heat flux vector. If the heat transfer is by conduction only, \( \mathbf{q} \) is determined by

\[
\mathbf{q} = -k \nabla T
\]

For a detailed discussion of the fundamentals of heat transfer see [1].

**Note:** *Heat capacity* refers to the quantity that represents the amount of heat required to change one unit of mass of a substance by one degree. It has units of energy per mass per degree. This quantity is also called *specific heat* or *specific heat capacity.*
The Conduction Application Mode

This application mode models heat transfer by conduction. It also includes convection and radiation effects around edges and boundaries. To start modeling with this application mode, go to the Model Navigator and select Heat Transfer and then Conduction.

Variables and Space Dimensions

The Conduction application mode is available in 1D, 2D, and 3D as well as for axisymmetric models using cylindrical coordinates in 1D and 2D. The dependent variable is the temperature, $T$.

PDE Formulation

The mathematical model for heat transfer by conduction is the following version of the heat equation

$$\delta_{ts} \rho C_p \frac{\partial T}{\partial t} - \nabla \cdot (k \nabla T) = Q$$

with the following material properties:

- $\delta_{ts}$ is a time-scaling coefficient.
- $\rho$ is the density.
- $C_p$ is the heat capacity.
- $k$ is the thermal conductivity tensor.
- $Q$ is the heat source (or sink).

For a steady-state problem the temperature does not change with time and the first term disappears.

In rare cases you might decide to add domain-specific transversal convection or radiation in 1D planar and axisymmetric models and 2D planar models. Represent this by adding the two terms on the right:

$$\delta_{ts} \rho C_p \frac{\partial T}{\partial t} - \nabla \cdot (k \nabla T) = Q + \frac{h_{\text{trans}}}{dA} (T_{\text{ext}} - T) + \frac{C_{\text{trans}}}{dA} (T_{\text{ambtrans}} - T^A)$$
where:

- $h_{\text{trans}}$ is the transversal convective heat transfer coefficient.
- $T_{\text{ext}}$ is the transversal external temperature.
- $C_{\text{trans}}$ is a user-defined constant.
- $T_{\text{ambtrans}}$ is the transversal ambient temperature.
- $dA$ is the thickness in 2D and area in 1D.

**Note:** When using transversal convection or radiation, the heat equation must be modified to accommodate the area $dA$. For all practical purposes the use of this feature is a rare exception, and the terms $h_{\text{trans}}$ and $C_{\text{trans}}$ are usually set to zero.

### Subdomain Settings

The subdomain quantities are:

<table>
<thead>
<tr>
<th>QUANTITY</th>
<th>VARIABLE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\delta_{ts}$</td>
<td>Dts</td>
<td>Time-scaling coefficient</td>
</tr>
<tr>
<td>$\rho$</td>
<td>rho</td>
<td>Density</td>
</tr>
<tr>
<td>$C_p$</td>
<td>C</td>
<td>Heat capacity</td>
</tr>
<tr>
<td>$k$</td>
<td>k</td>
<td>Thermal conductivity</td>
</tr>
<tr>
<td>$k_{ij}$</td>
<td>$k_{xi \cdot xj}$</td>
<td>Thermal conductivity tensor, $x_i \cdot x_j$ component</td>
</tr>
<tr>
<td>$Q$</td>
<td>Q</td>
<td>Heat source</td>
</tr>
<tr>
<td>$h_{\text{trans}}$</td>
<td>htrans</td>
<td>Transversal convective heat transfer coefficient</td>
</tr>
<tr>
<td>$T_{\text{ext}}$</td>
<td>Text</td>
<td>Transversal external temperature</td>
</tr>
<tr>
<td>$C_{\text{trans}}$</td>
<td>Ctrans</td>
<td>User-defined constant</td>
</tr>
<tr>
<td>$T_{\text{ambtrans}}$</td>
<td>Tambtrans</td>
<td>Transversal ambient temperature</td>
</tr>
</tbody>
</table>

**Time-scaling coefficient** This coefficient is normally 1, but you can change the time scale, for example, from seconds to minutes by setting it to $1/60$.

**Density** It specifies the material’s density. Enter this quantity as unit mass per unit volume.
**Heat capacity**  The heat capacity $C$ describes the amount of heat energy required to produce a unit temperature change in a unit mass.

**Thermal conductivity**  The thermal conductivity $k$ describes the relationship between the heat flux vector $\mathbf{q}$ and the temperature gradient $\nabla T$ as in

$$\mathbf{q} = -k \nabla T,$$

which is *Fourier’s law of heat conduction*. Enter this quantity as the unit power per unit length and unit temperature.

**Heat source**  The heat source describes heat generation within the domain. Express heating and cooling with positive and negative values, respectively. Enter the quantity $Q$ as the unit power per unit length in 1D; the unit power per unit area in 2D; and the unit power per unit volume in 3D.

**Boundary Condition Types**

The available boundary conditions are:

<table>
<thead>
<tr>
<th>BOUNDARY CONDITION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\mathbf{n} \cdot (k \nabla T) = q_0 + h(T_{\text{inf}} - T) + C_{\text{cons}}(T_{\text{amb}} - T^4)$</td>
<td>Heat flux</td>
</tr>
<tr>
<td>$\mathbf{n} \cdot (k \nabla T) = 0$</td>
<td>Insulation or symmetry</td>
</tr>
<tr>
<td>$T = T_0$</td>
<td>Prescribed temperature</td>
</tr>
<tr>
<td>$T = 0$</td>
<td>Zero temperature</td>
</tr>
</tbody>
</table>

**HEAT FLUX**

$$\mathbf{n} \cdot (k \nabla T) = q_0 + h(T_{\text{inf}} - T) + C_{\text{cons}}(T_{\text{amb}}^4 - T^4)$$

FEMLAB supplies only one generalized boundary condition for heat flux, but it accounts for general heat flux as well as heat flux from convection and radiation.

The application mode interprets the heat flux $q_0$ in the direction of the inward normal. It interprets the convection and radiation terms in the direction of the outward normal.

- Specify $q_0$ to represent a heat flux that enters the domain. For instance, any electric heater is well represented by this condition, and you can omit its geometry. Enter the quantity $q_0$ as unit power per unit area (W/m² using SI units). While this is
directly applicable to 3D, unit depth and unit area are assumed in 2D and 1D applications, respectively.

• $h(T_{\text{inf}} - T)$ models convective heat transfer with the surrounding environment, where $h$ is the heat transfer coefficient and $T_{\text{inf}}$ is the ambient bulk temperature. The value of $h$ depends on the geometry and the ambient flow conditions. For a thorough introduction on how to calculate heat transfer coefficients see [1].

• $C_{\text{const}} (T_{\text{amb}}^4 - T^4)$ models radiation heat transfer with the surrounding environment. $T_{\text{amb}}$ is the temperature of the surrounding radiation environment, which might differ from $T_{\text{inf}}$. $C_{\text{const}}$ is the product of the surface emissivity $\varepsilon$ and the Stefan-Boltzmann constant $\sigma = 5.67 \times 10^{-8} \text{W/m}^2/\text{K}^4$:

$$C_{\text{const}} = \varepsilon \sigma$$

The surface emissivity is a material property discussed and tabulated in [1].

**Note:** A problem with radiation boundaries is nonlinear. For stationary analyses you must use the nonlinear solver.

**INSULATION OR SYMMETRY**

$$\mathbf{n} \cdot (k \nabla T) = 0$$

This condition specifies where the domain is well insulated, or it reduces model size by taking advantage of symmetry. Intuitively this equation says that the gradient across the boundary must be zero. For this to be true, the temperature on one side of the boundary must equal the temperature on the other side. Because there is no temperature difference across the boundary, heat cannot transfer across it.

An interesting numerical check for convergence is the numerical evaluation of the above condition along the boundary, something easily accomplished with FEMLAB’s postprocessing features. Another check is to plot the temperature field as a contour plot. Ideally the contour lines are perpendicular to any insulated boundary.

**AXIAL SYMMETRY**

This boundary condition is available only for axisymmetric versions of the heat transfer application models. Use it only on the symmetry axis $r = 0$. 

---

146 | CHAPTER 7: HEAT TRANSFER
**PRESCRIBED TEMPERATURE**

$$T = T_0$$

This boundary prescribes the temperature $T_0$. This condition means that the finite element solution returns a solution in which the above condition is either true or minimally approximated.

**PRESCRIBED ZERO TEMPERATURE**

$$T = 0$$

This boundary specifies a zero boundary temperature.

**Boundary Settings**

You specify the boundary conditions in the *Boundary Settings* dialog box.

<table>
<thead>
<tr>
<th>QUANTITY</th>
<th>VARIABLE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>$q_0$</td>
<td>$q$</td>
<td>Inward heat flux</td>
</tr>
<tr>
<td>$h$</td>
<td>$h$</td>
<td>Convective heat transfer coefficient</td>
</tr>
<tr>
<td>$T_{inf}$</td>
<td>$T_{inf}$</td>
<td>Ambient bulk temperature</td>
</tr>
<tr>
<td>$Const$</td>
<td>$Const$</td>
<td>Radiation constant: product of emissivity and Stefan-Boltzmann constant</td>
</tr>
<tr>
<td>$T_{amb}$</td>
<td>$T_{amb}$</td>
<td>Temperature of the surrounding radiating environment</td>
</tr>
<tr>
<td>$T_0$</td>
<td>$T_0$</td>
<td>Prescribed temperature</td>
</tr>
</tbody>
</table>

**Application Mode Variables**

The Conduction application mode uses the following variables for domain equations, boundary equations, and postprocessing purposes.

<table>
<thead>
<tr>
<th>NAME</th>
<th>DOMAIN TYPE</th>
<th>DESCRIPTION</th>
<th>EXPRESSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>$T$</td>
<td>S/B</td>
<td>Temperature</td>
<td>$T$</td>
</tr>
<tr>
<td>$\text{grad}T, T_{x_i}$</td>
<td>S/V</td>
<td>Temperature gradient</td>
<td>$\nabla T, \frac{\partial T}{\partial x_i}$</td>
</tr>
<tr>
<td>$\text{flux}$</td>
<td>S</td>
<td>Heat flux</td>
<td>$-k \nabla T$</td>
</tr>
<tr>
<td>NAME</td>
<td>DOMAIN / TYPE</td>
<td>DESCRIPTION</td>
<td>EXPRESSION</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>-------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>nflux_T</td>
<td>B</td>
<td>Normal heat flux</td>
<td>( \mathbf{n} \cdot (-k \nabla T) )</td>
</tr>
<tr>
<td>fluxx_i</td>
<td>V</td>
<td>Heat flux, ( x_i ) component</td>
<td>( \sum -k_{ij} \frac{\partial T}{\partial x_j} )</td>
</tr>
<tr>
<td>Dts</td>
<td>S</td>
<td>Time-scaling coefficient</td>
<td>( \delta_{is} )</td>
</tr>
<tr>
<td>rho</td>
<td>S</td>
<td>Density</td>
<td>( \rho )</td>
</tr>
<tr>
<td>C</td>
<td>S</td>
<td>Heat capacity</td>
<td>( C_p )</td>
</tr>
<tr>
<td>k, k_i x_j</td>
<td>S</td>
<td>Thermal conductivity</td>
<td>( h, k_{ij} )</td>
</tr>
<tr>
<td>Q</td>
<td>S</td>
<td>Heat source</td>
<td>( Q )</td>
</tr>
<tr>
<td>htrans</td>
<td>S</td>
<td>Transversal convective heat transfer coeff.</td>
<td>( h_{trans} )</td>
</tr>
<tr>
<td>Text</td>
<td>S</td>
<td>Transversal external temperature</td>
<td>( T_{ext} )</td>
</tr>
<tr>
<td>Ctrans</td>
<td>S</td>
<td>User-defined constant</td>
<td>( C_{trans} )</td>
</tr>
<tr>
<td>Tambtrans</td>
<td>S</td>
<td>Transversal ambient temperature</td>
<td>( T_{ambtrans} )</td>
</tr>
<tr>
<td>T0</td>
<td>B</td>
<td>Prescribed temperature</td>
<td>( T_0 )</td>
</tr>
<tr>
<td>h</td>
<td>B</td>
<td>Convective heat transfer coefficient</td>
<td>( h )</td>
</tr>
<tr>
<td>Tinf</td>
<td>B</td>
<td>Ambient bulk temperature</td>
<td>( T_{inf} )</td>
</tr>
<tr>
<td>Const</td>
<td>B</td>
<td>Radiation constant: product of emissivity and Stefan-Boltzmann constant</td>
<td>( \text{Const} )</td>
</tr>
<tr>
<td>Tamb</td>
<td>B</td>
<td>Temperature of the surrounding radiating environment</td>
<td>( T_{amb} )</td>
</tr>
</tbody>
</table>

**Note:** The vector expressions V are not present in the 1D formulation of the Conduction application mode.
The Convection and Conduction Application Mode

In addition to heat transfer by conduction, the Convection and Conduction application mode includes heat transfer by convection. In the convection term for the equation that defines this application mode you can specify the velocity vector as an analytical expression. Alternatively, you can connect it directly to the solution of the equations of motion, for example, through a multiphysics coupling to the Incompressible Navier-Stokes application mode.

Variables and Space Dimensions

The Convection and Conduction application mode is available in 1D, 2D, 3D, Axial symmetry 1D, and Axial symmetry 2D.

**Note:** The optional Chemical Engineering Module also contains this Convection and Conduction application mode. In addition to the above-mentioned space dimensions, it features pseudo-2D and pseudo-3D geometry options in which it uses time as a second or third spatial dimension. This feature is useful in situations where convection in the direction of the flow is large. This often applies to reactors and equipment for unit operations.

**PDE Formulation**

In this application mode you can choose from two formulations:

\[
\delta_{ts}\rho C_p \frac{C T}{\rho C_p} + \nabla \cdot (-k \nabla T) = Q - \rho C_p u \cdot \nabla T \quad \text{(nonconservative)}
\]

\[
\delta_{ts}\rho C_p \frac{C T}{\rho C_p} + \nabla \cdot (-k \nabla T + \rho C_p u T) = Q \quad \text{(conservative)}
\]

In FEMLAB the nonconservative formulation is the default for advection and diffusion types of equations. It assumes an incompressible fluid, which means that \( \nabla \cdot u = 0 \). This ensures that no unphysical source term arises from a flow field where
the incompressibility constraint, $\nabla \cdot \mathbf{u} = 0$, is not absolutely fulfilled. The nonconservative formulation puts the convective term on the right-hand side of the equation, which implies that setting the temperature gradient to zero directly expresses the convective boundary condition. This procedure avoids the use of interpolation and gives higher accuracy. For convective boundary conditions in heat balances, where the flow is incompressible and given by Darcy’s law, the use of the nonconservative mode gives the most simple and accurate model definition.

You can toggle between the nonconservative and conservative forms in the Application Mode Properties dialog box by selecting them in the Equation form list.

### Subdomain Settings

The following table contains the quantities in the equations:

<table>
<thead>
<tr>
<th>COEFFICIENT</th>
<th>VARIABLE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\delta t_s$</td>
<td>$\Delta t_{s,T}$</td>
<td>Time-scaling coefficient</td>
</tr>
<tr>
<td>$\rho$</td>
<td>$\rho_{T}$</td>
<td>Density</td>
</tr>
<tr>
<td>$C_p$</td>
<td>$C_{T}$</td>
<td>Heat capacity</td>
</tr>
<tr>
<td>$k$</td>
<td>$k_{T}$</td>
<td>Thermal conductivity</td>
</tr>
<tr>
<td>$\mathbf{k}$</td>
<td>$\mathbf{k}_{T}$</td>
<td>Thermal conductivity tensor</td>
</tr>
<tr>
<td>$k_{ij}$</td>
<td>$k_{x_i x_j,T}$</td>
<td>Thermal conductivity tensor, $x_i x_j$ component</td>
</tr>
<tr>
<td>$Q$</td>
<td>$Q_{T}$</td>
<td>Heat source</td>
</tr>
<tr>
<td>$u, v, w$</td>
<td>$u_{T}, v_{T}, w_{T}$</td>
<td>Velocity in the $x_1$-, $x_2$-, and $x_3$-direction</td>
</tr>
</tbody>
</table>

For equations in 2D or 3D, pay special attention to the isotropic thermal conductivity, $k$. If you select this coefficient, the application mode expands it to the diagonal of the thermal conductivity tensor, that is, $k_{ij} = k$.

### Artificial Diffusion

The Convection and Conduction application mode supports artificial diffusion using the following methods:

- Isotropic diffusion
- Streamline diffusion
- Crosswind diffusion

To specify and activate artificial diffusion:

1. Open the Subdomain Settings dialog box.
2. Click the Physics tab.

3. With at least one subdomain selected, click the Artificial Diffusion button.


### Boundary Conditions

The available boundary conditions are:

<table>
<thead>
<tr>
<th>BOUNDARY CONDITION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>$T = T_0$</td>
<td>Temperature</td>
</tr>
<tr>
<td>$-\mathbf{n} \cdot (-k \nabla T + \rho C_p u T) = q_0$</td>
<td>Heat flux</td>
</tr>
<tr>
<td>$\mathbf{n} \cdot (-k \nabla T + \rho C_p u T) = 0$</td>
<td>Insulation/symmetry</td>
</tr>
<tr>
<td>$\mathbf{n} \cdot (-k \nabla T) = 0$</td>
<td>Convective flux</td>
</tr>
<tr>
<td>$\mathbf{n} \cdot (-k \nabla T + \rho C_p u T) = 0$</td>
<td>Axial symmetry</td>
</tr>
</tbody>
</table>

The only difference between this mode and the Conduction application mode is that the heat flux contains the added convection term. In cases where convection across a boundary is much greater than diffusion, use the convective flux boundary condition. It sets the diffusive flux at the boundary to zero, but it allows convective flux to exit the domain.

**Note:** When working in an axisymmetry application mode, use the axial symmetry boundary condition only on the symmetry axis.

### Application Mode Variables

The Convection and Conduction application mode uses the following expressions and coefficients in boundary conditions, equations, and for postprocessing purposes.

<table>
<thead>
<tr>
<th>NAME</th>
<th>TYPE</th>
<th>DESCRIPTION</th>
<th>EXPRESSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>$T$</td>
<td>S/B</td>
<td>Temperature</td>
<td>$T$</td>
</tr>
<tr>
<td>$\nabla T$</td>
<td>S/V</td>
<td>Temperature gradient</td>
<td>$</td>
</tr>
<tr>
<td>NAME</td>
<td>TYPE</td>
<td>DESCRIPTION</td>
<td>EXPRESSION</td>
</tr>
<tr>
<td>-----------</td>
<td>------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>dflux_T</td>
<td>S</td>
<td>Conductive flux</td>
<td>(</td>
</tr>
<tr>
<td>cflux_T</td>
<td>S</td>
<td>Convective flux</td>
<td>(</td>
</tr>
<tr>
<td>tflux_T</td>
<td>S</td>
<td>Total heat flux</td>
<td>(</td>
</tr>
<tr>
<td>ndflux_T</td>
<td>B</td>
<td>Normal conductive flux</td>
<td>(n \cdot (-k \nabla T))</td>
</tr>
<tr>
<td>ncfux_T</td>
<td>B</td>
<td>Normal convective flux</td>
<td>(pC_p T u \cdot u)</td>
</tr>
<tr>
<td>ntflux_T</td>
<td>B</td>
<td>Normal total heat flux</td>
<td>(n \cdot (-k \nabla T + pC_p Tu))</td>
</tr>
<tr>
<td>dflux_T_xi</td>
<td>V</td>
<td>Conductive flux, (x_i) component</td>
<td>(\sum_k -k_{ij} \frac{\partial T}{\partial x_j})</td>
</tr>
<tr>
<td>cflux_T_xi</td>
<td>V</td>
<td>Convective flux, (x_i) component</td>
<td>(pC_p T u_i)</td>
</tr>
<tr>
<td>tflux_T_xi</td>
<td>V</td>
<td>Total heat flux, (x_i) component</td>
<td>(\sum_k -k_{ij} \frac{\partial T}{\partial x_j} + pC_p T u_i)</td>
</tr>
<tr>
<td>cellPe_T</td>
<td>S</td>
<td>Cell Peclet number</td>
<td>(\left</td>
</tr>
<tr>
<td>Dts_T</td>
<td>S</td>
<td>Time-scale factor</td>
<td>(\delta_{ts})</td>
</tr>
<tr>
<td>rho_T</td>
<td>S</td>
<td>Density</td>
<td>(\rho)</td>
</tr>
<tr>
<td>C_T</td>
<td>S</td>
<td>Heat capacity</td>
<td>(C_p)</td>
</tr>
<tr>
<td>k_T, k_{xj_T}</td>
<td>S</td>
<td>Thermal conductivity</td>
<td>(k, k_{ij})</td>
</tr>
<tr>
<td>Q_T</td>
<td>S</td>
<td>Heat source</td>
<td>(Q)</td>
</tr>
<tr>
<td>u_T, v_T, w_T</td>
<td>S</td>
<td>Velocity of (c, x_i) component</td>
<td>(u_i)</td>
</tr>
<tr>
<td>Dm_T</td>
<td>S</td>
<td>Mean diffusion coefficient</td>
<td>(\sum_{ij} k_{ij}\beta_i\beta_j)</td>
</tr>
<tr>
<td>res_T_cc</td>
<td>S</td>
<td>Equation residual</td>
<td>(\nabla \cdot (-k \nabla T + pC_p Tu) - Q)</td>
</tr>
<tr>
<td>res_sc_T_cc</td>
<td>S</td>
<td>Shock-capturing residual</td>
<td>(\nabla \cdot (pC_p Tu) - Q)</td>
</tr>
<tr>
<td>da_T</td>
<td>S</td>
<td>Total time-scale factor</td>
<td>(\delta_{ts} pC_p)</td>
</tr>
<tr>
<td>q</td>
<td>B</td>
<td>Inward heat flux</td>
<td>(q_0)</td>
</tr>
<tr>
<td>T0</td>
<td>B</td>
<td>Prescribed temperature</td>
<td>(T_0)</td>
</tr>
</tbody>
</table>
The vector variables, indicated by V in the Type column, are not present in 1D versions of the Convection and Conduction application mode.
Examples of Heat Transfer Models

The following three heat transfer benchmark examples show how to model heat transfer using:

- Steady-state and transient analysis
- Temperature, heat flux, convective cooling, and radiation boundary conditions
- Thermal conductivity as a function of temperature

All examples are taken from a NAFEMS benchmark collection [2].

1D Steady-State Heat Transfer with Radiation

The first example shows a 1D steady-state thermal analysis including radiation to a prescribed ambient temperature.

Model Definition

This 1D model has a domain of length 0.1 m. The left end is kept at 1000 K, and at the right end there is radiation to 300 K. For the radiation, the model properties are:

- The emissivity, ε, is 0.98.
- The Stefan-Boltzmann constant, σ, is 5.67 \times 10^{-8} \text{ W/m}^4\text{K}^4.

In the domain, use the following material properties:

- The density, \( \rho \), is 7850 kg/m^3.
- The heat capacity is 460 J/kg°C.
- The thermal conductivity is 55.563 W/m°C.
Results

The following plot shows the temperature as a function of position:

![Temperature as a function of position](image)

Figure 7-1: Temperature as a function of position.

The benchmark result for the right end is a temperature of 927.0 K. The FEMLAB model, using a default mesh with 15 elements, gives a temperature at the end as 926.97 K, which is the exact benchmark value to four significant digits.

Model Library path: FEMLAB/Heat_Transfer/heat_radiation_1D

Modeling Using the Graphical User Interface

MODEL NAVIGATOR

1. Go to the Model Navigator and select 1D in the Space dimension list.
2. In the Application mode list, open the Heat Transfer folder and then the Conduction node.
3. Select Steady-state analysis.
4. Click OK.
OPTIONS AND SETTINGS

1. Go to the Options menu and choose Constants.
2. Enter the following constants for the emissivity and the Stefan-Boltzmann constant:

<table>
<thead>
<tr>
<th>NAME</th>
<th>EXPRESSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>emissivity</td>
<td>0.98</td>
</tr>
<tr>
<td>sigma</td>
<td>5.67e-8</td>
</tr>
</tbody>
</table>

GEOMETRY MODELING

1. Go to the Draw menu, point to Specify Objects and click Line.
2. In the Line dialog box, type 0 0.1 in the x edit field under Coordinates.
3. Click OK.
4. Click the Zoom Extents button.

PHYSICS SETTINGS

Boundary Conditions
1. Go to the Physics menu and choose Boundary Settings.
2. In the Boundary Settings dialog box select boundary 1.
3. In the Boundary condition list select Temperature.
4. Enter 1000 in the Temperature edit field.
5. Select boundary 2.
6. In the Boundary condition list select Heat flux.
7. Type emissivity*sigma in the Problem-dependent constant edit field.
8. Type 300 in the Ambient temperature edit field.
1 Go to the Physics menu and choose Subdomain Settings.

2 In the Subdomain Settings dialog box enter the thermal properties in the domain according to the following table:

<table>
<thead>
<tr>
<th>SUBDOMAIN</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>k (isotropic)</td>
<td>55.563</td>
</tr>
<tr>
<td>ρ</td>
<td>7850</td>
</tr>
<tr>
<td>C_p</td>
<td>460</td>
</tr>
</tbody>
</table>
Set the initial value to match the boundary condition. It serves as starting value for the nonlinear solver:

3. Click the Init tab.
4. Type 1000 as the initial value in the Temperature edit field.
5. Click OK.

MESH GENERATION
Initialize the mesh by clicking the Initialize Mesh button on the Main toolbar.

SOLVING THE MODEL
1. Go to the Solve menu and choose Solver Parameters.
2. In the Solver list select Stationary nonlinear.
3. Click OK.
4. Click the **Solve** button.

**POSTPROCESSING AND VISUALIZATION**

Figure 7-1 on page 155 shows the temperature distribution in the domain. Use the zoom tools to focus on the temperature at the right end.

**2D Steady-State Heat Transfer with Convection**

This example shows a 2D steady-state thermal analysis including convection to a prescribed external (ambient) temperature.

**Model Definition**

This model domain is 0.6 x 1.0 meters. For the boundary conditions:

- The left boundary is insulated.
- The lower boundary is kept at 100 °C.
- The upper and right boundaries are convecting to 0 °C with a heat transfer coefficient of 750 W/m²°C.

In the domain use the following material properties:

- The density, \( \rho \), is 7850 kg/m³.
• The heat capacity is 460 J/kg°C.
• The thermal conductivity is 52 W/m°C.

**Results**

The following plot shows the temperature as a function of position:

![Temperature distribution](image)

*Figure 7-2: Temperature distribution resulting from convection to a prescribed external temperature.*

The benchmark result for the target location \((x = 0.6 \text{ m} \text{ and } y = 0.2 \text{ m})\) is a temperature of 18.25 °C. The FEMLAB model, using a default mesh with 556 elements, gives a temperature of 18.28 °C. Successive uniform refinements show a temperature of 18.26 and 18.25 °C, converging toward the benchmark result.

**Model Library path:** FEMLAB/Heat_Transfer/heat_convection_2D

**Modeling Using the Graphical User Interface**

**MODEL NAVIGATOR**
1. Go to the Model Navigator and select 2D in the Space dimension list.
2 In the Application mode list, open the Heat Transfer folder and then the Conduction node.

3 Select Steady-state analysis.

4 Click OK.

GEOMETRY MODELING

1 On the Draw menu point to Specify Objects and click Rectangle.

2 In the Rectangle dialog box, find the Size area and type 0.6 in the Width edit field, then type 1 in the Height edit field.

3 Click OK.

4 Click the Zoom Extents button.

PHYSICS SETTINGS

Boundary Conditions
The default boundary condition is thermal insulation, so you must set boundary conditions for only three of the boundaries.

1 Go to the Physics menu and choose Boundary Settings.

2 In the Boundary Settings dialog box select boundary 2.

3 In the Boundary condition list select Temperature.

4 Type 100 in the Temperature edit field.

5 Select boundaries 3 and 4.

6 In the Boundary condition list select Heat flux.

7 Type 750 in the Heat transfer coefficient edit field.
Subdomain Settings

1. Go to the Physics menu and choose Subdomain Settings.
2. In the Subdomain Settings dialog box enter the thermal properties in the domain according to the following table:

<table>
<thead>
<tr>
<th>SUBDOMAIN</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>k (isotropic)</td>
<td>52</td>
</tr>
<tr>
<td>ρ</td>
<td>7850</td>
</tr>
<tr>
<td>C_p</td>
<td>460</td>
</tr>
</tbody>
</table>

3. Click OK.

Mesh Generation

Initialize the mesh by clicking the Initialize Mesh button on the Main toolbar.

Solving the Model

Click the Solve button.

Postprocessing and Visualization

Figure 7.2 on page 160 shows the temperature distribution in the domain. To get a plot showing the numerical value at the reference point, use a cross-section plot:

1. Go to the Postprocessing menu and choose Cross-Section Plot Parameters.
2. In the Cross-Section Plot Parameters dialog box click the Point tab.
3. In the Coordinates area enter 0.6 in the x edit field and 0.2 in the y edit field.
4 Click Apply.

2D Axisymmetric Transient Heat Transfer

This example shows an axisymmetric transient thermal analysis with a step change to 1000 °C at time 0.

Model Definition

This model domain is 0.3 x 0.4 meters. For the boundary conditions:

• The left boundary is the symmetry axis.
• The other boundaries have a temperature of 1000 °C. The entire domain is at 0 °C at the start, which represents a step change in temperature at the boundaries.

In the domain use the following material properties:

• The density, \( \rho \), is 7850 kg/m\(^3\).
• The heat capacity is 460 J/kg\(\cdot\)\(^\circ\)C.
• The thermal conductivity is 52 W/m\(\cdot\)\(^\circ\)C.
Results

The following plot shows temperature as a function of position after 190 seconds:

![Temperature distribution after 190 seconds.](image)

The benchmark result for the target location \((r = 0.1 \text{ m} \text{ and } z = 0.3 \text{ m})\) is a temperature of 186.5 °C. The FEMLAB model, using a default mesh with 712 elements, gives a temperature of 186.52 °C.

**Model Library path:** `FEMLAB/Heat_Transfer/heat_transient_axi`

**Modeling Using the Graphical User Interface**

**Model Navigator**

1. Go the Model Navigator and select Axial symmetry (2D) in the Space dimension list.
2. In the Application mode list, open the Heat Transfer folder and then the Conduction node.
3. Select Transient analysis.
4. Click OK.
GEOMETRY MODELING

1. Go to the Draw menu, point to Specify Objects and click Rectangle.
2. In the Rectangle dialog box go to the Size area and enter 0.3 in the Width edit field and 0.4 in the Height edit field.
3. Click OK.
4. Click the Zoom Extents button.

PHYSICS SETTINGS

Boundary Conditions
The default boundary condition is thermal insulation, so you need to set boundary conditions only for three of the boundaries.

1. Go to the Physics menu and choose Boundary Settings.
2. In the Boundary Settings dialog box select boundary 1.
3. In the Boundary condition list select Axial symmetry.
4. Select the Select by group check box and choose boundaries 2, 3, and 4 by selecting one of them.
5. Select Temperature in the Boundary condition list.
6. Type 1000 in the Temperature edit field.
7. Click OK.

Subdomain Settings

1. Go to the Physics menu and choose Subdomain Settings.
2 In the **Subdomain Settings** dialog box enter the thermal properties in the domain according to the following table:

<table>
<thead>
<tr>
<th>SUBDOMAIN</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>$k$ (isotropic)</td>
<td>52</td>
</tr>
<tr>
<td>$\rho$</td>
<td>7850</td>
</tr>
<tr>
<td>$c_p$</td>
<td>460</td>
</tr>
</tbody>
</table>

3 Click **OK**.

**MESH GENERATION**

Initialize the mesh by clicking the **Initialize Mesh** button on the Main toolbar.

**SOLVING THE MODEL**

1 Go to the **Solve** menu and choose **Solver Parameters**.
2 In the **Time stepping** area in the **Solver Parameters** dialog box enter $0:10:190$ in the **Times** edit field.
3 Click **OK**.
4 Click the **Solve** button.

**POSTPROCESSING AND VISUALIZATION**

Figure 7-3 on page 164 shows the temperature distribution in the domain. To get a plot showing the numerical value at the reference point, use a cross-section plot:

1 Go to the **Postprocessing** menu and choose **Cross-Section Plot Parameters**.
2 In the **Cross-Section Plot Parameters** dialog box click the **Point** tab.
3 Select the **Point plot** button.
4 Under **Coordinates** enter $0.1$ in the $r$ edit field and $0.3$ in the $z$ edit field.
5 Click **Apply**.

You can also click in the temperature plot at (0.1, 0.3) to display the temperature at that point in the Message Log.

**References**

